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ABSTRAK 
 

Survei batimetri bertujuan untuk memetakan topografi dasar perairan. Teknologi survei 
kelautan khususnya survei batimetri mengalami perkembangan yang pesat. Salah satu instrumen 
yang digunakan untuk akuisisi data kedalaman adalah multibeam echosounder dengan 
memanfaatkan teknologi gelombang akustik.  

Multibeam echosounder mengukur kedalaman tidak hanya yang tepat dibawah transduser, 
namun juga kedalaman pada sisi-sisinya (tegak lurus halu kapal). Volume data yang besar hasil 
survei multibeam menjadikan pengolahan data secara manual menjadi tidak efisien. Oleh karena itu 
diperlukan perangkat lunak dan perangkat keras komputer yang khusus ditujukan untuk mengolah 
data multibeam.  

Pengolahan data multibeam echosounder menggunakan perangkat lunak PDS (Product Data 
Sheet) 2000 dapat mengolah data dalam jumlah besar, memiliki tingkat ketelitian yang baik dan 
menghasilkan data kedalaman yang cukup representatif. 

 
Kata kunci : Multibeam echosounder, PDS 2000 
 
 

 
 

ABSTRACT 
 

The purpose of bathymetric survey is to map seabed topography. Technology of ocean 
survey, basically in bathymetric has been improving significantly. One of the instrument to acquire 
depth data is multibeam echosounder, which using acoustic wave technology.  

Multibeam echosounder measures depth not only correct bellow transduser, but also depth at 
sides (vertical heading of ship). Large data volume resulted from multibeam survey, makes manually 
data process become inefficient. Therefore, it needs computer hardware and software specially built 
for multibeam data process. 

 Multibeam echosounder data processing applies the software PDS (Product Data Sheet) 
2000 which is able to process data in large amount, has an excellent accuracy and produce the 
representative data of the depth. 
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Latar Belakang 
 
 Survei dan pemetaan hidrografi 
merupakan suatu rangkaian kegiatan 
pengumpulan, pengolahan dan penyajian data 
atau informasi melalui pengukuran lapangan, 
pencitraan fenomena fisik permukaan bumi 
yang terdiri atas air dan daratan yang 
berbatasan dengan laut beserta proses di 
dalamnya untuk keperluan pelayaran (utama) 
dan semua keperluan dan aktivitas kelautan 
lainnya, termasuk di antaranya aktivitas lepas 
pantai, penelitian, perlindungan lingkungan, 
dan pelayanan prediksi.  

Pemetaan dasar laut menggunakan 
sistem multibeam echosounder akan lebih 
sering digunakan pada saat ini sebagai 
pelengkap dari singlebeam echosounder yang 
telah banyak digunakan pada beberapa 
dekade terakhir. 
 Pengolahan data multibeam 
echosounder hasil survei dapat dilakukan 
dengan bantuan teknologi komputer. 
Pengolahan data dengan berbasis komputer 
memiliki banyak keunggulan diantaranya 
dapat melakukan proses pengolahan data 
survei batimetri dalam kuantitas yang besar 
dengan waktu yang relatif singkat. Kesalahan 
yang ditimbulkan karena faktor manusia dapat 
dikurangi dengan pemanfaatan teknologi 
tersebut.  
 Kemajuan teknologi komputer telah 
mendorong programmer membuat perangkat 
lunak untuk pengolahan hasil survei batimetri 
khususnya untuk pengolahan data multibeam 
echosounder. Hasil dari pengolahan data ini 
akan diperoleh output berupa peta digital 
dalam berbagai skala serta visualisasi yang 
beraneka ragam (Digital Terrain Model, kontur, 
profil dan lain sebagainya). Saat ini telah 
beredar di pasaran berbagai perangkat lunak 
yang ditujukan untuk pengolahan data survei 
batimetri, baik yang bersifat komersil maupun 
open source seperti Caris Hips, Hypack, 
Qinsy, Fledermause, GeoSwath plus (GS+) 
dan PDS 2000. 
 Makalah ini membahas tentang 
proses pengolahan data multibeam 
echosounder  menggunakan perangkat lunak 
PDS 2000, yang merupakan produk dan 
pengembangan perangkat lunak komersil dari 
perusahaan Reson B.V.  
 

 
Tujuan 
 
  Makalah ini bertujuan untuk 
memberikan suatu petunjuk teknik tentang 
tahapan proses pengolahan data multibeam 
echosounder menggunakan perangkat lunak 

PDS 2000. 
 
 
Batasan Masalah 
 

Makalah  ini menjelaskan proses 
pengolahan data batimetri multibeam 
echosounder menggunakan perangkat lunak 
PDS 2000 dengan hasil berupa X, Y, Z 
menggunakan data yang diperoleh dari 
kegiatan Latma STTAL Jurusan Hidro-
Oseanografi di Perairan Selat Sunda. 
 
 
Alir kerja pengolahan data PDS 2000 
 

 
 
 
 

Lokasi Dan Waktu Pengambilan  Data 
Penelitian  
 

Pengambilan dilaksanakan di Perairan 
Selat Sunda dari tanggal 16 s.d 21 September 
2014 dengan batas area sebagai berikut : 
A. 06°01’ 00” S dan 105° 54’16” T 
B. 06°01’ 22” S dan 105° 54’42” T 
C. 06°02’ 07” S dan 105° 54’00” T 
D. 06°01’ 41” S dan 105° 53’35” T 
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 Area Survei (Peta Laut No. 71A Dishidros  

TNI AL Pengeluaran Kedua Juni 2006 Sekala 
1:100.000) 

 
 

PELAKSANAAN PENGOLAHAN DATA 
MULTIBEAM DENGAN PDS 2000 

 
1.  Tahap persiapan data 
  
 Persiapan data dan manajemen file 
yang rapi merupakan hal yang penting karena 
dapat membantu kelancaran proses 
pengolahan. Data yang diperlukan pada saat 
pengolahan data antara lain : 
a. Data pemeruman multibeam 

Pengambilan data kedalaman 
menggunakan alat Multibeam 
Echosounder Reson T-20 dengan 
akusisi data menggunakan perangkat 
lunak PDS 2000 dengan format ‘pds’. 
Untuk penentuan posisi menggunakan 
DGPS Hemisphere Vector VS 131. 
 

b. Konfigurasi kapal 
Data yang berisikan dimensi dan titik 
referensi kapal yang digunakan untuk 
kegiatan survei seperti kedudukan 
antena receiver GPS dan transduser 
terhadap titik referensi kapal untuk 
mengetahui posisi setiap data 
kedalaman dalam system koordinat 
global. 
Nilai offset peralatan di kapal  
 

 X (m) Y (m) Z (m) 

DMS 05 0.00 0.00 0.00 

GPS 1.00 0.15 1.90 

T 20-P 1.66 3.75 -1.50 

Zerro 
Offset 

0.00 0.00 0.00 

 

c. Data pasang surut 
Pengambilan data pasang surut untuk 
koreksi surutan dilaksanakan 
menggunakan Tide Gauge Valeport 
740  pada posisi 06º 2' 48,6" LS - 105º 
55' 22,1" BT. Data dalam bentuk 
format ‘txt’.  
 

d. Data profil kecepatan suara 
Pengambilan data kecepatan suara 
(SVP) menggunakan alat CTD AML 
Minos.X dilaksanakan di area survei  
dengan kecepatan suara berkisar 
1541,2 – 1541,6 m/s, dengan 
kedalaman 0,1 – 26 m. Data dalam 
bentuk format ‘csv’. 
 

e. Data kalibrasi alat/ Patch Test 
Data Patch Test berisikan nilai 
kalibrasi pemeruman roll, pitch dan 
yaw dalam format pds dan pdf.  
 
Hasil dari pengolahan Patch test 

Roll Pitch Yaw 

0,56 4,58 -1,96 

 
2. Tahap Pengolahan Data 
 
 Tahap pengolahan data meliputi data 
hasil survei batimetri yang telah dilakukan 
dengan mengikuti alur kerja yang terdapat 
pada perangkat PDS 2000 
 
2.1. Membuat Project Baru 
 Membuat project baru dimulai dengan 
memasukkan data berupa nama project, 
project configuration seperti deskripsi, unit, 
koordinat sistem, format, log file dan 
penentuan aplikasi survei,  Bila pada saat 
mengolah data hasil survei menggunakan 
komputer lain, file harus dicopy  dulu dari 
komputer akuisisi ke lokasi komputer 
pengolahan. Jika PDS 2000 dimulai untuk 
pertama kali, maka tak ada project yang 
dipilih. Adalah mungkin untuk memulai wizard 
project baru secara langsung setelah start up.  

A 

B 

C 

D 
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Window Project dengan pilihan Run the New 

Project Wizard 
 

Jika tidak ada project yang tersedia 
dalam folder project, kemudian akan muncul 
sebuah pesan pada jendela display. Klik pada  

 dalam jendela kesalahan jendela 
Select Project akan dibuka. 

Jika PDS 2000 telah dimulai dengan 
project yang sudah ada, wizard new project 
dapat dimuai dari menu Control Center 
dengan File > New project. Tindakan ini akan 
memulai jendela dialog pertama dari wizard.  
 

 
Memulai wizard project baru. 

 
Bila tidak memiliki data project tetapi 

hanya file PDS 2000, project dapat dibuat dari 
PDS Log File. PDS akan menghasilkan project 
dari data dan memindahkan file yang dipilih ke 
direktori Log Data Project. Kemungkinan sisa 
file log PDS 2000 dapat dipindahkan/ disalin 
ke folder log data dalam proyek yang 
dihasilkan folder dengan menggunakan 
Windows Explorer.  

 

 
Membuat project dari PDS Log File 

 
2.2. Control Center (Explorer) 

PDS 2000 menggunakan berbagai 
jenis file data untuk pengaturan penyimpanan 
informasi yang relevan. Di dalam explorer, 
struktur directori dibuat dengan folder terpisah 
untuk setiap jenis data. Semua file data dapat 
diakses melalui Explorer. Project Database di 
Control Center menunjukkan kelompok file 
dengan semua pengaturan dan file data untuk 
proyek yang dipilih. File dapat dibuka dengan 
memilih Project tab di bagian atas Explorer. 
File-file proyek ini terkait dan karenanya hanya 
dapat digunakan dalam proyek yang dipilih. 
Sebagian besar modul di PDS 2000 membaca 
informasi dalam proyek database ketika modul 
dimulai. 
 
2.2.1 *pds 2000 log data 
 Memasukkan data survei dengan cara 
membuka file project yang telah dibuat 
sebagai tempat untuk menyimpan raw data. 
Memasukkan data survei ke dalam log data di 
Control Center dapat dilakukan per lajur atau 
sekaligus selama pelaksanaan survei.  
 

 
Data survei di PDS 2000 log data Control 

Center 
 

2.2.2 Vessel  
PDS 2000 selalu membutuhkan 

konfigurasi kapal untuk pengolahan data. 
Konfigurasi kapal berisi semua pengaturan 
yang diperlukan untuk melakukan semua 
pengukuran. 

Pada saat pengolahan data, data 
konfigurasi kapal diperoleh dari instalasi alat 
pada perahu perum dengan mengukur posisi 
alat terhadap center dari perahu tersebut. 
Perubahan nilai roll, pitch dan yaw setelah 
kalibrasi dimasukkan ke dalam Computations 
Vessel-Vessel [Multibeam Survey].  
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 Memasukkan file vessel ke project PDS 2000 
 
2.2.3 Tide (surutan) 
 Data surutan berisikan informasi 
mengenai waktu dan tinggi muka air yang 
telah disurutkan terhadap chart datum. Data 
selama survei dimasukkan ke dalam Project 
Tide Stations dengan memasukkan parameter 
tanggal, waktu, interval waktu dan nilai 
surutan.  

 

 
Grafik Pasut 

 
2.2.4 SVP 
 Untuk mengetahui nilai perambatan 
gelombang suara dalam lapisan air digunakan 
alat ukur CTD (Conductivity Temperature 
Depth) Nilai dimasukkan ke dalam Project 
Sound Velocity Profiler dengan memasukkan 
parameter tanggal dan waktu pengambilan 
data, kedalaman, kecepatan gelombang 
suara, salinitas dan suhu.  
 

 
Grafik Sound Velocity Profiler di area survei. 

 
 

2.2.5 Kalibrasi Patch Test 
PDS 2000 memiliki modul kalibrasi 

yang berdiri sendiri dan sebagai bagian 
terpadu dari modul pengolahan data. Sebuah 
kalibrasi yang diusulkan nilainya akan dihitung 
dan ditempatkan dalam kotak pengaturan. 

Profil area dapat dipindahkan ke 
posisi yang berbeda untuk mendapatkan profil 
kalibrasi yang terbaik dan memeriksa solusi 
yang ditemukan. PDS 2000 memberitahukan 
bila korelasi yang baik atau buruk ditemukan.  

 
2.3 Replay Raw Data 
 Data yang direkam oleh log data PDS 
2000 dengan format *pds dari pelaksanaan 
survei dapat diputar ulang (replay) untuk 
mendapatkan data baru yang telah 
termanipulasi, mengecek bearing lajur survei 
pada saat akuisisi sesuai dengan rencana 
survei dan juga bisa untuk mengambil gambar 
obyek atau target di dasar laut. Data yang di 
replay dapat dibedakan dari file asli dengan 
tambahan format “R”, tanggal dan waktu 
replay di nama file. 
 
2.4 Editing 

Pengolah data Echosounder 
Multibeam dapat memeriksa data untuk 
outlier, anomali dan mengukur kesalahan. Jika 
perlu, adalah mungkin untuk menghapus atau 
memperbaiki data. Setiap tampilan masing-
masing editor di ambil dari PDS 2000 data file. 
 
2.4.1 Position Editing  
 Proses pengeditan digunakan untuk 
menghilangkan penyimpangan-penyimpangan 
data pada saat proses pengambilan data. 
Data navigasi yang diperoleh merupakan data 
posisi horizontal kapal selama survei 
berlangsung dengan menggunakan receiver 
DGPS Hemisphere Vector VS 131 dengan 
metode RTK. 
 
2.4.2 Time-Base Editing 
 Pengeditan Time Base Editing 
digunakan untuk mengoreksi sensor data 
pergerakan kapal dari MRU (Motion Reference 
Unit) yang dipasang pada kapal selama survei 
berlangsung akibat dinamika laut dan 
memberikan informasi nilai gyro, pitch, roll, 
heave. Tampilan standar juga dapat 
digunakan untuk mengecek reduksi 
kedalaman. 
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Tampilan Time Base Editing Standard 

 
2.4.3 Apply tide (surutan) 

Sebelum data surutan diterapkan ke 
file, data surutan dapat di edit atau di periksa 
dengan Tools > Edit Tide Station Data From 
dari menu bar. Pilih Tools > Apply Tide dari 
menu bar untuk menambahkan data surutan 
untuk file log data. Pilih mode perhitungan 
untuk satu atau lebih stasiun pasut. Pilih 

 untuk menambahkan ke file log data 
dalam file yang ditetapkan. 

Data surutan yang sudah dibuat 
dalam project tide station diaktifkan sesuai 
dengan tanggal waktu di area survei. 

 
 
2.4.4 Apply SVP 

Pilih Sound Velocity Mode  untuk 
membuka sound velocity editor. Editor ini 
merupakan bagian dari tampilan SVP Edit 
Profil yang menunjukkan profil kecepatan 
suara pada waktu survei dilapangan dengan 
profil area yang dipilih.   

Disamping profil svp saat survei, profil 
svp kedua dapat dipilih dengan opsi yang 
dapat diedit. Profil kecepatan suara yang 
dipilih ditampilkan dalam warna merah dengan 
kotak-kotak kecil yang dapat dipindahkan. 

Opsi single file dipilih ketika 
memperbarui, modifikasi data hanya data aktif 
dari file log data. 

Opsi multi file dipilih ketika 
memperbarui, modifikasi semua file log data. 
Opsi multi file dapat digunakan untuk 
memodifikasi profil kecepatan suara untuk 
satu set file yang menggunakan profil 
kecepatan suara yang sama. Jika data dari file 
set tidak cocok karena profil kecepatan suara, 
maka dengan beberapa modifikasi kecil profil 
kecepatan suara dapat disesuaikan.  

 
2.4.5 Apply Patch Test 

Setelah didapatkan nilai roll, pitch dan 
yaw, pilih Full Calibrate dan  Apply calibration 
settings pilih : 
a. Logging… : Bila ditambahkan ke 
log data 

b. Fileset… : Bila ditambahkan ke 
data Fileset 
c. Vessel… : Bila ditambahkan ke 
vessel setting  

 

 
Setting data kalibrasi 

 
Untuk mengetahui nilai koreksi posisi 

tranduser dari hasil pengolahan patch test, 
nilai kalibrasi roll, pitch dan yaw dimasukkan 
ke dalam modul processing calibration.  

 
2.4.6 Beam Filter (auto) 

Proses filter bisa dilakukan secara 
online pada saat aquisisi pengambilan data di 
lapangan dan waktu pengolahan data.  
Filtering data dapat digunakan bersama-sama 
atau dalam urutan acak :  
a. Menggunakan Filter setting 
b. Menggunakan CUBE Model 
c. Menggunakan Grid Model 

Prosedur kerja Reson menyarankan 
untuk sebagian besar data set sebagai berikut: 
a. Menggunakan filter pengaturan filter 

statistik (juga dapat diatur selama 
akuisisi) 

b. Membuat CUBE atau Grid Model 
dengan ukuran sel grid sekitar 5% 
atau 10% dari kedalaman. 

c. Filter data multibeam dengan 
terhadap CUBE model atau grid 
model. 

d. Menggunakan filter automatis dan 
secara komprehensif memeriksa hasil 
filtering dalam pengolahan data 
sebelum pelaksanaan filter secara 
manual. 

 
2.4.7 Manual reject beam (ping view) 

Pada tahap ini, data outlier, spike-
spike  dan data batimetri dari kesalahan 
pembacaan kedalaman setelah melalui beam 
filter (auto) akan dibuang. Bila terdapat outliers 
lakukan pengkotakan / polylen terhadap 
outliers tersebut dengan menggunakan delete 
mode. Data beam yang akan di filter bisa 
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dilakukan per-line atau beberapa line 
sekaligus. 

Dalam mengedit data, data dapat 
dihapus, dipindahkan untuk memodifikasi titik-
titik data yang berbeda untuk tampilan 3D, 
Ping View dan Profile View dimana data dapat 
di edit.  
 
2.4.8 Create Grid Model 

Grid model atau di sebut juga DTM 
(Digital Terrain Model) merupakan 
representasi digital dari permukaan bumi. 
Model ini biasanya dibuat dengan data survei 
atau data lain 3D. Sebuah model terdiri dari 
sejumlah sel dimana setiap sel dapat berisi 
satu atau lebih tipe data. Sel-sel dari grid 
model selalu persegi dengan sisi sejajar grid 
proyeksi.  

 

 
Membuat grid model baru di Multibeam Area 

Editing-Standard View. 
 
2.5 Validasi data 

Validasi data digunakan untuk 
mengetahui keabsahan pengolahan data 
multibeam melalui pengecekan lajur perum 
yang overlap pada koordinat yang sama 
dengan menggunakan metode grid model 
yang diterapkan pada data agar memenuhi 
standar IHO S-44 Tahun 2008 Edisi ke 5. 

 
2.6 Grid Model Editor 

Dengan grid model editor, perhitungan 
model grid dapat dibuat dan di edit. Beberapa 
grid dapat terbuka di editor secara bersamaan, 
tetapi hanya satu grid yang aktif dan dapat di 
edit. 

Model dapat ditampilkan di window 
display dengan View > Displays dan menutup 
model dengan File > Close. Hal ini akan 
menghapusnya dari tampilan, tetapi model 
tersebut masih tersedia di display window 
dengan setting pengaturan tersendiri. 

Dianjurkan untuk membuat daftar grid 
model dengan tampilan layar yang tidak terlalu 

besar. Setiap saat dengan  dari toolbar di 
Control Center, semua grid model editor dapat 
di buka di window display. Hal ini 
mengakibatkan fakta bahwa grid model tidak 
bisa dibuka atau membuka dengan sangat 
lambat. Lebih baik adalah dengan 
menggunakan combo box dari grid model 
editor untuk membuka salah satu grid model 
yang lain. 

Base surface merupakan hasil dari 
representasi metode grid model yang 
diterapkan pada data multibeam echosounder. 
Gambar dengan skala warna untuk 
membedakan kedalaman laut dapat 
ditampilkan dalam bentuk 2D dan 3 D dengan 
pencahayaan yang dapat diatur. 
 
2.6.1 Interpolasi Circuler 

Di dalam grid model editor 
memungkinkan untuk menghasilkan data grid 
model baru dan menerapkan berbagai proses. 
Interpolasi circuler digunakan biasanya 
digunakan untuk lubang kecil dalam data. 
Gaps atau lubang-lubang kecil ini dapat 
disebabkan misalnya oleh beam terluar dari 
sebuah survei multibeam. 
 Tergantung pada ukuran area 
interpolasi dan kekuatan dari komputer, 
interpolasi ini dapat dikerjakan pada waktu 
yang singkat atau lama. Cara terbaik 
menggunakan petunjuk ini adalah ketika ada 
gaps atau lubang kecil area dalam jumlah 
yang banyak seperti dalam data multibeam. 
 
2.6.2 Set Colour 

Di dalam grid model properties, 
pengaturan pencahayaan matahari dapat 
dipilih untuk mengubah grid model. Limit batas 
kedalaman minimum dan maksimum dapat di 
setting untuk pengeplotan pewarnaan. 

 

 
Setting sun illumination 

 
2.7 Tin Model 
 Dengan TIN Model Viewer, dapat 
dibuat dan divisualisasikan tampilan gambar 
3D dan interval kontur kedalaman. Tidak ada 
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fungsi untuk modifikasi data. TIN Model 
Viewer bisa dimulai dengan Processing> TIN 
Model Viewer . Untuk menampilkan kontur 
dengan Tools > Generate Contour dari menu 
bar.  
 
 
2.8 Export Data 

Export pada PDS 2000 dibuat untuk 
mengekspor file log data PDS 2000 ke format 
file yang dapat digunakan dengan program 
eksternal lain. Ekspor bisa dimulai dengan 
Tools > Eksport from dari menu bar atau 

dengan   dari toolbar di Control Center.  
Setelah tahap grid model editor dan 

TIN Model Viewer data diekspor ke dalam 
format ASCII *XYZ dan GeoTIFF untuk proses 
lebih lanjut penggambaran pada perangkat 
lunak AutoCAD. 

 
 

HASIL DAN PEMBAHASAN 
 
1. Kalibrasi patch test sangat penting 
dalam kegiatan survei sebagai jaminan untuk 
mendapatkan nilai ketelitian (accuracy) pada 
pengukuran kedalaman laut. Pengolahan data 
multibeam echosounder pada makalah ini 
menggunakan hasil  patch test  setelah 
kegiatan di lapangan.  

 

 
Tampilan koreksi data Patch Test 

 
 
2. Koreksi data SVP 

Untuk menentukan kedalaman, 
kecepatan suara (sound velocity) pada kolom 
air harus diketahui dengan tepat. Setelah 
dilaksanakan koreksi data SVP sesuai dengan 
tanggal pelaksanaan survei di area lapangan, 
di peroleh gambar per lajur dengan profil yang 
menyambung tidak terputus. Di samping 
koreksi data surutan dan kalibrasi patch test,  
koreksi data SVP sangat berperan untuk 
menentukan kontrol kualitas survei multibeam. 

Apabila pada waktu pengambilan data 
svp terdapat noise, data SVP yang 
dimasukkan dapat di edit dan di modifikasi. 

 

 
Profil SVP sesuai dengan data asli dari CTD 

 

 
Profil SVP setelah dilaksanakan modifikasi 

 
Pada gambar diatas terlihat ada profil 

yang putus antar lajur dan menandakan 
pengolahan data yang kurang bagus. Dari 
hasil di atas disimpulkan bahwa noise pada 
SVP dapat menyebabkan noise pada hasil 
akhir citra dasar laut, sehingga untuk 
menghasilkan pengolahan data yang baik, 
maka sebelum SVP dimasukkan untuk koreksi 
beam, sebaiknya data SVP harus diolah 
terlebih dahulu. 
 
3. Editing Data 

Untuk mempercepat proses 
menghapus outlier dan penyimpangan pada 
beam terluar setiap lajur yang biasanya 
menghasilkan rata-rata hasil sapuan yang 
kurang bagus, dapat dilakukan beam filter 
(auto) dengan menggunakan filter setting nadir 
filter. Sudut kanan dan kiri pada saat 
pengambilan data yang sudah disetting 72º, 
dikurangi masing-masing 7º di setingan 
multibeam filter seperti gambar berikut. 

 

 
Nadir filter sebelum di reject. 
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Nadir filter setelah di reject. 

 
Dengan menggunakan penyaringan 

manual delete mode pada pengolahan 
multibeam, data penyimpangan dan outlier 
yang belum terhapus dengan filter setting 
dapat dihilangkan. Gambar dibawah 
merupakan contoh tampilan outlier yang 
dihapus dengan manual editing.  

 

 
Outlier yang belum terhapus filter auto 

 

 
Outlier yang sudah dihapus dengan delete 

manual 
 

 
Tampilan lajur di Multibeam area edting 

standard   
 

Selain menggunakan filter setting dan 
manual delete mode, proses editing 
membuang outlier dapat dilakukan dengan 
menggunakan filter grid model. Filter dapat 
diatur dengan kriteria utama adalah jarak 
vertikal antara data multibeam dan grid model. 

Berikut gambar dibawah contoh 
tampilan filter automatis menggunakan filter 
grid model pada saat pengolahan data.  

 

 
Filter menggunakan Grid Model 

 
Beam dengan batas diatas dan 

dibawah 1 meter akan di tolak (reject) ketika 
jarak vertikal antara Z beam dan grid model 
lebih besar dari  standar deviasi sel grid model 
yang dimasukkan . 
 Editing data dilakukan perlajur perum, 
hingga semua lajur perum tervalidasi. 
  
4. Validasi data 
 Pengukuran batimetri pada survei 
hidrografi diperlukan adanya koreksi 
kedalaman antara lajur perlajur yang sudah 
direncanakan. Pada pengolahan dengan grid 
model, di peroleh rata-rata nilai total standar 
deviasi 0,20. 

Pada pengecekan lajur perum 1 dan 2 
yang overlap di posisi horizontal 9334262-
600424 dan 9334262-600426 dengan area 
kecil polygon diperoleh data-data sebagai 
berikut: 

 
  

Area overlap lajur 1 dan lajur 2 
 
Tabel dua posisi horizontal pada lajur yang 
overlap :  

Metode Grid 
Model 

Posisi 

9334262/600424 9334262/600426 

Lajur 1 36.71 m 36.65 m 

Lajur 2 36.34 m 36.93 m 

Selisih 
kedalaman 

0.37 m 0.28 m 

Rata-rata 36.52 m 36.79 m 

δ Orde 1 ± 0.37 ± 0.37 

Orde 1-IHO memenuhi memenuhi 

 
Dari rata-rata standar deviasi seluruh data grid 
model dan lajur yang overlap, diketahui 
pengolahan dengan grid model dapat 
digunakan untuk pembuatan produk batimetri. 
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5.  Interpolasi Circuler 
 Di dalam interpolasi circuler, Max. gap 
adalah jarak terjauh dimana interpolasi masih 
valid atau dapat dilakukan. Interpolasi ini akan 
mencari sel yang kosong di dalam clipping 
polygon atau jaringan area yang lengkap dan 
mengisi sel yang kosong tersebut dengan 
rata-rata tertimbang dari data asli. Jarak 
maksimum gap yang akan diinterpolasi dapat 
ditentukan dalam satuan meter. 
 

 
Sebelum Interpolasi circuler 

 

 
Sesudah Interpolasi circuler 

 
6. Menampilkan angka kedalaman 
 Angka kedalaman dapat ditampilkan 
di grid model editor dengan mengaktifkan grid 
model edit layer dan menambahkan 
Annotation Data type Z Average. Gambar  
berikut merupakan contoh tampilan dari  
angka kedalaman. 
 

 
Angka kedalaman pada lajur 10 dan 11 di area 

survei 
 

7. Kontur kedalaman 
 Pembuatan kontur kedalaman 
dilaksanakan dengan menggunakan TIN 

Model Viewer. Kontur kedalaman dapat di 
setting sesuai dengan peta laut yang 
diterbitkan oleh Dishidros yaitu kontur 0 (nol), 
kontur 2 (dua), kontur 5 (lima), kontur 10 
(sepuluh), kontur 20 (dua puluh), kontur 30 
(tiga puluh), kontur 40 (empat puluh) dan 
kontur 50 (lima puluh). Hasil pembuatan 
kontur dapat di simpan dalam format file ASCII 
*XYZ. 

Pada gambar di bawah dapat dilihat 
bahwa kedalaman area survei bervariasi 
dengan angka kedalaman berkisar antara 29-
55 m di bawah permukaan laut.   

 
Keseluruhan area survei 3D dengan TIN 

Model Viewer 
 

8. Export Data 
Setelah melalui proses grid model 

editor dan TIN model viewer, semua data yang 
telah terkoreksi dengan surutan dan Sound 
Velocity selanjutnya di export ke dalam format 
ASCII *XYZ untuk proses lebih lanjut 
penggambaran pada perangkat lunak 
AutoCAD. Data di export dalam bentuk X,Y,Z 
dan GeoTIFF. 

Setiap sel dengan tipe data yang 
dipilih akan memberikan nilai X, Y dan Z, di 
mana X dan Y adalah pusat sel dan tipe Z 
merupakan data kedalaman. Pengaturan 
pencahayaan matahari (sun illumination) 
digunakan untuk pewarnaan yang 
menghasilkan GeoTIFF tersebut.  

 

 
Base surface dalam bentuk XYZ dan GeoTIFF 
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Kesimpulan 
 
 Dari hasil pengolahan multibeam 
echosounder menggunakan perangkat lunak 
PDS 2000 dihasilkan kesimpulan sebagai 
berikut : 
a. Kualitas hasil pengolahan data 

multibeam sangat tergantung pada 
saat pelaksanaan pengambilan data di 
lapangan, patch test dan ketelitian  
pengolahan data dalam hal editing / 
filtering data. 

b. Memasukkan data koreksi pasang 
surut (tide) dan sound velocity dengan 
format tertentu harus sesuai dengan 
format kolom yang tersedia agar 
proses koreksi dapat dilaksanakan.   

c. Dalam editing, data dapat diedit dalam 
file data dan langsung dapat dikoreksi 
setelah diedit. Ukuran file akan 
bertambah secara signifikan dan file 
data diproses terpisah dari data base 
dengan membentuk satu file. Hal ini 
memungkinkan pengguna untuk 
kembali ke data asli (raw data) ketika 
dibutuhkan. 

d. Proses filtering secara otomatis 
dilaksanakan sebelum pengeditan 
manual akan mempercepat proses 
pengolahan data multibeam dengan 
memperhatikan data-data yang valid. 
Jika dalam penyaringan/ filtering telah 
dihapus terlalu banyak data-data yang 
valid, pengolah data dapat mengatur 
ulang filter dan memulai lagi. Dalam 
modul pengolahan, data mentah dapat 
dipulihkan setiap saat. 

 
 
Saran. 
a. Spesifikasi komputer pengolah data 

disarankan di atas standar minimal 
yang ditetapkan oleh perangkat lunak 
agar proses pengolahan data lebih 
cepat. 

b. Bagi mahasiswa yang akan 
mengambil tema tugas akhir tentang 
pengolahan menggunakan perangkat 
lunak PDS 2000 dapat melaksanakan 
pengolahan dengan CUBE Mode 
untuk membandingkan base surface 
yang dihasilkan dan penggambaran 
ke dalam lembar lukis menggunakan 
PDS Plot . 

c. Pengolahan data MBES 
menggunakan perangkat lunak PDS 
2000 relatif tidak sulit dilaksanakan 
dan dapat direkomendasikan sebagai 
perangkat lunak alternatif lain yang 
sudah dimiliki oleh Dishidros. 
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